PERFORMANCE

MADE
SMARTER

Product manual
5343

2-wire level transmitter

Seguranca

& BEE & I = Ex 0 ce

TEMPERATURE | I|.S.INTERFACES | COMMUNICATION INTERFACES | MULTIFUNCTIONAL | ISOLATION | DISPLAY

No. 5343V107-UK P-R

From ser. no. 141298001 electronics



6 Product Pillars
to meet your every need

Individually outstanding, unrivalled in combination

With our innovative, patented technologies, we make signal conditioning smarter and simpler. Our portfolio is composed of six
product areas, where we offer a wide range of analog and digital devices covering over a thousand applications in industrial
and factory automation. All our products comply with or surpass the highest industry standards, ensuring reliability in even
the harshest of environments and have a 5-year warranty for greater peace of mind.
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Our range of temperature transmitters and sensors provides the highest level of signal integrity from the
measurement point to your control system. You can convert industrial process temperature signals to analog, bus or
digital communications using a highly reliable point-to-point solution with a fast response time, automatic self-
calibration, sensor error detection, low drift, and top EMC performance in any environment.

We deliver the safest signals by validating our products against the toughest safety standards. Through our
commitment to innovation, we have made pioneering achievements in developing |.S. interfaces with SIL 2 Full
Assessment that are both efficient and cost-effective. Our comprehensive range of analog and digital intrinsically
safe isolation barriers offers multifunctional inputs and outputs, making PR an easy-to-implement site standard.
Our backplanes further simplify large installations and provide seamless integration to standard DCS systems.

We provide inexpensive, easy-to-use, future-ready communication interfaces that can access your PR installed base
of products. All the interfaces are detachable, have a built-in display for readout of process values and diagnostics,
and can be configured via push-buttons. Product specific functionality includes communication via Modbus and
Bluetooth and remote access using our PR Process Supervisor (PPS) application, available for iOS and Android.

Our unique range of single devices covering multiple applications is easily deployable as your site standard. Having
one variant that applies to a broad range of applications can reduce your installation time and training, and greatly
simplify spare parts management at your facilities. Our devices are designed for long-term signal accuracy, low
power consumption, immunity to electrical noise and simple programming.

Our compact, fast, high-quality 6 mm isolators are based on microprocessor technology to provide exceptional
performance and EMC-immunity for dedicated applications at a very low total cost of ownership. They can be
stacked both vertically and horizontally with no air gap separation between units required.

Our display range is characterized by its flexibility and stability. The devices meet nearly every demand for display
readout of process signals, and have universal input and power supply capabilities. They provide a real-time
measurement of your process value no matter the industry, and are engineered to provide a user-friendly and
reliable relay of information, even in demanding environments.
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2-wire level transmitter
5343

Potentiometer or Ohmic input

Programmable sensor error value

High measurement accuracy

Unique process calibration function

Programmable via standard PC

Application Applications
e Conversion of resistance variation to standard analog

current signals, e.g. from Ohmic level sensors or valve

positions. Ohmic level sensor Z'i‘é‘”crgn'{‘rscﬁarléaot[f”
e User-defined linearization function can be activated. t0 4..20 mA

Technical characteristics

e Within a few seconds the user can program PR5343 to
measure within the defined Ohmic values.

e Continuous check of vital stored data for safety reasons.

e The transmitter is protected against polarity reversal.

e PR5343is configured to the current task by way of a PC,
the PRelevel software and the communications interface

Loop Link.

e The PRelevel configuration tool included in the PReset o .
software has been developed specifically for the Potentiometer Z}wlcrg[wrsotlarlcl)%trlr?n
configuration of level applications. Among other things, it t0 4..20 mA
contains a function for "on line” measurement of input ©

span as well as a linearization function for volume linear
output from horizontal cylindrical tanks.
Mounting / installation

e For DIN form B sensor head mounting. In non-hazardous
areas the 5343 can be mounted on a DIN rail with a special
fitting.

i

2-wire installation
. in control room
Resistance t0 4..20 mA

4 5343V107-UK



Order

Type Version

5343 |Standard ‘A
ATEX, FM, IECEx & INMETRO ‘B

Electrical specifications

Environmental conditions:

Operating temperature . . . . . . . . oo -40°C to +85°C
Calibration temperature. . . . . . . . . ... . 20...28°C
Humidity. . . . . < 95% RH (non-cond.)
Protection degree, enclosure / terminals. . . . ... ............... IP68 / IPOO
Mechanical specifications:
DIMeNnsions . . . . . @44 x 20.2 mm
Weight. . . . . 50¢g
MaX. WIre Size. . . . . o oo 1 x1.5 mm? stranded wire
Screw terminal torque. . . . . . . .. e 0.4 Nm
Vibration. . . . . . IEC60068-2-6
2.25Hz. +1.6 mm
25.100Hz. . ... t4g
Common specifications:
Supply voltage, DC
Standard. . . ... 8.0..35VDC
ATEX, FM, IECEX & INMETRO. . . . . . . . e 8.0..30 VDC
Internal power dissipation
Standard. . . ... 25 mw..0.8 W
ATEX, FM, IECEX & INMETRO. . . . . . . . e e 25 mW..0.7 W
Voltage drop . . . . . . 8.0 vDC
Warm-up time. . . . . . . 5 min.
Programming . . . . . . . . . Loop Link
Signal/noiseratio. . ... ... .. . Min. 60 dB
Response time (programmable) . . . . ... ... ... . . oL 0.33..60s
Signal dynamics, input . . . . ... 19 bit
Signal dynamics, output . . . . ... 16 bit
Effect of supply voltage variation. . . . . ......... ... .. ... . .... < 0.005% of span / VDC

Accuracy, the greater of general and basic values:

General values

Input type Absolute accuracy Temperature coefficient

Lin.R < +0.1% of span < +#0.01% of span/°C

Basic values

Input type Basic accuracy Temperature coefficient
Lin.R <+0.05Q <+0.002 Q/°C
EMC - immunity influence. . . . . ... ... ... .. ... . < +0.5% of span

5343V107-UK



Electrical specifications, input:
Linear resistance input:

Measurement raNge . & .« . v v v e 0..100kQ
Min. measurement range (SPan). . . . . v v 1kQ
Max. offset . . . . .. 50% of selec. max. value
Cableresistance perwire (Max.). . . . . . v v vttt 100Q
SeNSOr CUMENT . . . v o o >25pA, <120 pA
Effect of sensor cable resistance (3-wire) . . . . ... ... ... .. <0.0020Q/Q
Sensor errordetection . . .. . ... Yes
Output:
Current output:
Signalrange. . . . . . . . e 4..20 mA
Min.signalrange. . . . . ... . .. . 16 mA
Updatingtime . . ... ... .. . . . . . . 135 ms
Load resistance. . . . . . . o < (Vsupply - 8.0) /0.023 [Q]
Loadstability. . . . . . .. . < +0.01% of span /100 Q
Sensor error detection:
Programmable . . . . . . . . 3.5.23 mA
Namur NE43 Upscale . . . . . . . o 23 mA
Namur NE43 Downscale . . . . . ... 3.5mA
Of span = Of the presently selected range
Observed authority requirements:
EMC. . e 2014/30/eU
ROHS . . 2011/65/€eU
ATEX . 2014/34/eU
EAC . e TR-CU 020/2011
Marine approval:
DNV-GL, Ships & Offshore . . . ... ... ... .. . ... . . ... . ... ... Standard for Certification No. 2.4
Ex /LS. approvals:
ATEX:
5343 A, KEMA 10ATEX0004 X
5343B. . KEMA 03ATEX1538 X
IECEX. . o o DEK 13.0036 X
FM FM17US0013X
INMETRO . . . . DEKRA 16.0014 X
EACEXTR-CUOL2/2011. . . . . . e RU C-DK.GB08.V.00410

5343V107-UK



Connections

Input:

Potentiometer,
3-wire Resistance, 2-wire Resistance, 3-wire

3 4 6 34 6 3 4 6
WO 0 WV O 00 &

los] el sl

Output:
2-wire installation
1 2

£y £y

e

Block diagram

Supply +
11 8..35VDC
Ohmic | 3wirepoten- @—) DC *@*—K} o<
measurement | tiometer 4 mA
‘ } Input+ 16 bc
|
‘
}‘J | c
R omm.
- ! 1 Wiper_14 CPU
\ [ o MUX @ AID |—
L
|
| LE! l
| Input- D/A
| L
0...]A6
"
Supply -
20
5343 4.20mA
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Programming

e Loop Link is a communications interface that is needed for programming 5343.
e For programming please refer to the drawing below and the help functions in PReset.
e Loop link is not approved for communication with modules installed in harzardous (Ex) areas.

Receiving
Disconnect Equipment
1 . » e °+Vsupply
* Yellow
2 _ \Red o Input

/
, =Green

PRetop 5343

Connector

Loop Link

5909 - USB

*Connected only for
‘on-line" programming

Mechanical specifications Mounting of sensor wires

Wires must be mounted
between the metal plates.

|2 A I SN B AN B B

33 mm 20.2 mm

@44 mm

8 5343V107-UK



Configuration of potentiometer input

In an Ohmic level sensor the resistance value changes when a magnetic floater activates the reed contacts in the sensor. This
means that it is usually not possible to make use of the entire level sensor as input span. When PR5343 is used with a
potentiometer input, the PRelevel software contains the following special functions for configuration:

[Calibration Password] is 4711. This password should be entered at program start. The only parameters which can be
changed without entering this password are Input Low and High for the potentiometer input. The menu item is located under
Tools > Options.

Please pay special attention to the text in the ‘Information’ window during transmission. When the configuration cannot be
sent to the transmitter due to lack of password, the following text will appear: ‘Operation aborted.’ 'Configuration NOT
transmitted to the device.

The following description of configuration with potentiometer input is based on figure 1. Please note that the PRelevel
software only comes in an English-language version. Therefore the menu texts are represented here as they are seen on the
screen. First choose the [Input] tab:

A % of tank height % of level sensor
A

100 7

100

90 1 190

80 T 180

70 + 170
60 1 T 60
50 1 1%

| 140
40 1

Input in % of height

1 130
30 1 1
1 120
20 t

«———— Electrical Calibration —————>»|

<«—— Placement Calibration

10 +

Figure 1, cross section of horizontal cylindrical tank

[Electrical Calibration] Enter the range to be detected by the connected potentiometer or let PRelevel measure the available
range. The transmitter must be connected to the communications interface before the values can be measured.
The values in figure 1 are Low = 3% og High = 97%.

[Placement Calibration] Enter the placement of the ‘Electrical Calibration’ Low and High points of the level sensor in relation
to the height of the tank. These values are used for calculation of linearization values and for calculation of 0 and 100%
height.

The values in figure 1 are Low = 9% and High = 94%.

[Input] Enter the desired input span in relation to the height. When input Low and High are selected as 0 and 100%, the input
can never go below 9% and above 94% due to the design and mounting of the level sensor. If the output spanis 4...20 mA,
the output will only vary between 5.44...19.04 mA.

The values in figure 1 are Low = 0% and High = 100%.

5343V107-UK 9



Activation of embedded linearisations

The PRelevel software contains embedded linearization functions for horizontal cylindrical tanks and spherical tanks. The
linearization functions can be activated as follows:

Custom input type: In order to gain access to a customer-defined linearization, the selection in the [General Type] input box
must end with the text ‘Custom’ and the [Calibration Password] 4711 must be entered.

Activation of linearization: Choose the [Options] tab in the PRelevel 5343 window. If one of the embedded linearizations is
to be used, the selection in the ‘Linearization’ window must be ‘Polynomial.....(Relative)' in order to retrieve the most accurate
linearization files. The files are retrieved by way of the following menus: >Specify + select >File > Open in the main menu +
select >File name >Open in the file dialogue box.

User-defined linearization: It is possible to enter specific linearization tables in the >Specify menu.

10 5343V107-UK



R

electronics 5343QA02

LERBAKKEN 10, 8410 RGNDE DENMARK. WWW.PRELECTRONICS.COM

ATEX Installation drawing

For safe installation of 5343A the following must be observed. The module shall only be installed
by qualified personnel who are familiar with the national and international laws, directives and
standards that apply to this area.

Year of manufacture can be taken from the first two digits in the serial number.

ATEX Certificate KEMA 10ATEX 0004X

Marking @ Il 3G Ex nA [ic] IIC T4 ... T6 Gc
Il 3G Ex ic IIC T4...T6 Gc

I3 D ExicllIC Dc
Standards EN 60079-0 : 2012, EN 60079-11 : 2012, EN 60079-15 : 2010

T4: -40<Ta<85°C Terminal: 3,4,6 Terminal: 1,2 Terminal: 1,2

T6: -40<Ta<60°C ExnA [ic] Ex nA Exic
Uo: 5V Umax <35VDC Ui=35VDC
lo: 4mA li=110 mA
Po: 20 mW Li =10 uH
Lo: 900 mH Ci=1.0nF
Co: 1000 pF

Special conditions for safe use.

For type of protection Ex nA, the transmitter shall be mounted in a metal enclosure providing a
degree of protection of at least IP54 according to EN60529.

For use in the presence of combustible dusts the transmitter shall be mounted in an enclosure
providing a degree of protection of at least IP6X in accordance with o EN60529, the surface
temperature of the outer enclosure is 20 K above the ambient temperature

For an ambient temperature = 60°C, heat resistant cables shall be used with a rating of at least
20 K above the ambient temperature.

Revision date: Version Revision Page:
2013-08-07 V2R0 11
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ATEX Installation drawing

For safe installation of 5343B the following must be observed. The module shall only be installed by
qualified personnel who are familiar with the national and international laws, directives and
standards that apply to this area.

Year of manufacture can be taken from the first two digits in the serial number.

ATEX Certificate KEMA 03ATEX 1538 X

Marking @ 11 GExiallC T4..T6 Ga
I11 D ExialllC Da
I11 MExialMa

Standards EN 60079-0 : 2012, EN 60079-11 : 2012, EN 60079-26 : 2007,

Hazardous area

Zone 0, 1, 2, 20, 21, 22 Non Hazardous Area

|
T4. -40<Ta<85°C :
|

T6: -40 < Ta < 60°C
. 6
Terminal: 3,4,6 |
Uo: 30 VDC 5 ] I N
lo: 8 mA |
Po: 60 mW 4 2=
Lo: 35 mH |
Co: 66 nF 3
5343B |
| Barrier
Terminal: 1,2
Ui: 30 VDC |
li: 120 mA
Pi: 0.84 W |
Li: 10 uH
Ci: 1.0nF
Revision date: Version Revision Page:
2013-08-07 V2R0 1/2
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Installation notes.

In a potentially explosive gas atmosphere, the transmitter shall be mounted in an enclosure in
order to provide a degree of protection of at least IP20 according to EN60529.

If the transmitter is installed in an explosive atmosphere requiring the use of equipment of
category 1 G, 1 M or 2 M, and if the enclosure is made of aluminum, if must be installed such,
that ignition sources due to impact and friction sparks are excluded.

If the enclosure is made of non-metallic materials, electrostatic charging shall be avoided.

For installation in a potentially explosive dust atmosphere, the following instructions apply:
The transmitter shall be mounted in a metal enclosure form B according to DIN43729 that is
providing a degree of protection of at least IP6X according to EN60529, that is suitable for the

application and correctly installed.

Cable entries and blanking elements shall be used that are suitable for the application and
correctly installed.

For an ambient temperature = 60°C, heat resistant cables shall be used with a rating of at least
20 K above the ambient temperature.

The surface temperature of the enclosure is equal to the ambient temperature plus 20 K, for a
dust layer with a thickness up to 5 mm.

Revision date: Version Revision Page:
2013-08-07 V2RO 2/2
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IECEX Installation drawing

For safe installation of 5343A the following must be observed. The module shall only be installed
by qualified personnel who are familiar with the national and international laws, directives and
standards that apply to this area.

Year of manufacture can be taken from the first two digits in the serial number.

Certificate IECEx DEK 13.0036X
Marking Ex nA [ic] IIC T6..T4 Gc T4: 40 < Ta<85C
Ex ic IIC T6..T4 Gc 0 = T 2 Ao
Ex ic IlIC D¢ T6: -40 < Ta<60°C
Standards IEC 60079-0 : 2011, IEC 60079-11 : 2011, IEC 60079-15 : 2010
Terminal Ex nA [ic] Exic
1,2 Umax = 35 V Ui: 35V, 1i:110 mA, 1:10 pH, Cii1,0 nF
34,6 Uo: 5V, Io: 4 mA, Po: 20 mW, Lo: 900 mH, Co: 1000 pF

Installation note:
For installation in a potentialy explosive gas atmosphere, the following instructions apply:

For nA installation the transmitter must be installed in an metal enclosure e.g. a form B
enclosure, providing a degree of protection of at least IP54 according to IEC60529 that is
suitable for the application and correctly installed or in an enclosure with type of protection Ex
norExe.

For intrinsically safe installation the transmitter must be installed in enclosure providing a
degree of protection of at least IP20 according to IEC60529 and that is suitable for the
application.

Cable entry devices and blanking elements shall fulfill the same requirements

For an ambient temperature = 60°C, heat resistant cables shall be used with a rating of at
least 20 K above the ambient temperature.

For installation in a potentially explosive dust atmposphere, the following instructions apply:
The surface temperature of the enclosure is equal to the ambient temperature plus 20 K, for a
dust layer with a thickness up to 5 mm.
The transmitter must be mounted in a enclosure according to DIN 43729 that provides a
degree of protection of at least IP6X according to IEC60529, and that is suitable for the
application. Cable entry devices and blanking elements shall fulfill the same requirements.

Revision date: Version Revision Page:
2013-06-03 V1RO 11
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IECEX Installation drawing

For safe installation of 5343B the following must be observed. The module shall only be Installed by
qualified personnel who are familiar with the national and international laws, directives and
standards that apply to this area.

Year of manufacture can be taken from the first two digits in the serial number.

Certificate IECEx DEK 13.0036X
Marking Exia lIC T4...T6 Ga
Exia IIIC Da
Exia | Ma
Standards IEC 60079-0 : 2011, IEC 60079-11 : 2011, IEC 60079-26:2006

Hazardous area
Zone 0, 1, 2, 20, 21, 22, M1 Non Hazardous Area

T4: -40 < Ta<85°C
T5: -40 < Ta<60°C
T6: -40 < Ta<45°C

Terminal: 3,4,6 6 |
Uo: 30 VDC 1 I
lo: 8 mA |
Po: 60 mW 4 2}
Lo: 35 mH |
Co: 66 nF —3 5343B
| Barrier
Terminal: 1,2 |
Ui: 30 VDC |
li: 120 mA
Pi: 0.84 W |
Li: 10 yH
Ci: 1.0nF
Revision date: Version Revision OPage:
2013-06-03 V1RO 1/2
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Installation notes.

In a potentially explosive gas atmosphere, the transmitter shall be mounted in a metal form B
enclosure in order to provide a degree of protection of at least IP20 according to IEC60529. If
however the environment requires a higher degree of protection, this shall be taken into
account.

If the transmitter is installed in an explosive atmosphere requiring the use of equipment
protection level Ga, Ma and Mb, and if the enclosure is made of aluminum, it must be installed
such, that ignition sources due to impact and friction sparks are excluded.

For installation in a potentially explosive dust atmosphere, the following instructions apply:

For explosive dust atmospheres, the surface temperature of the outer enclosure is 20 K above
the ambient temperature.

The transmitter shall be mounted in a metal enclosure form B according to DIN43729 that is
providing a degree of protection of at least IP6X according to IEC60529, that is suitable for the
application and correctly installed.

Cable entries and blanking elements shall be used that are suitable for the application and
correctly installed.

For an ambient temperature = 60°C, heat resistant cables shall be used with a rating of at least
20 K above the ambient temperature.

Revision date: Version Revision OPage:
2013-06-03 V1RO 2/2
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FM Installation Drawing

Model 5331D, 5332D, 5333D and 5343B

Hazardous (Classified) Location

Class |,Division1, Groups, A,B,C,D T4..T6
Class |, Zone 0, AEx ia IIC T4..T6

Ambient temperature limits

Non Hazardous Location

T4:-40 to + 85 deg. Celcius
T6: -40 to + 60 deg. Celcius

Terminal 1,2
Vmax or Ui: 30 V
Imax or li: 120 mA
Pmax or Pi: 0.84 W
Ci: 1 nF

Li:10 uH

Terminal 3,4,5,6
VtorUo: 9.6 V

It or lo: 28 mA

Pt or Po: 67.2 mW
Caor Co: 3.5 uF
La or Lo: 35 mH

SENSOR

Model 5335D, 5337D

Hazardous (Classified) Location

Class |,Division1, Groups, A,B,C,D T4..T6
Class |, Zone 0, AEx ia IIC T4..T6

Ambient temperature limits

e e e s s s s

Associated Apparatus
or Barrier
with
entity Parameters:

UM < 250V

Voc or Uo < Vmax or Ui
Iscorlo < Imaxorli
Po < Pi

Ca or Co > Ci + Ccable
LaorLo >Li+Lcable

This device must not be connected
to any associated apparatus which
uses or generates more than 250
VRMS

Non Hazardous Location

T4: -40 to + 85 deg. Celcius
T6: -40 to + 60 deg. Celcius

Terminal 1, 2
Vmax or Ui: 30 V
Imax or li: 120 mA
Pmax or Pi: 0.84 W
Ci: 1nF

Li:10 uH

Terminal 3,4,5,6
VtorUo: 9.6 V

It or lo: 28 mA

Pt or Po: 67.2 mW
Caor Co: 3.5 uF
La or Lo: 35 mH

SENSOR

Associated Apparatus
or Barrier
with
entity Parameters:

UM < 250V

Voc or Uo < Vmax or Ui
Iscorlo < Imaxorli
Po < Pi

Ca or Co > Ci + Ccable
LaorLo >Li+ Lcable

This device must not be connected
to any associated apparatus which
uses or generates more than 250
VRMS

Revision date:
2018-08-27 V3RO

Version Revision

5343V107-UK
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The entity concept
The Transmitter must be installed according to National Electrical Code (ANSI-NFPA 70) and shall be
installed with the enclosure, mounting, and spacing segregation requirement of the ultimate application.

Equipment that is FM-approved for intrinsic safety may be connected to barriers based on the ENTITY

CONCEPT. This concept permits interconnection of approved transmitters, meters and other devices in
combinations which have not been specifically examined by FM, provided that the agency's criteria are
met. The combination is then intrinsically safe, if the entity concept is acceptable to the authority having
jurisdiction over the installation.

The entity concept criteria are as follows:

The intrinsically safe devices, other than barriers, must not be a source of power.

The maximum voltage Ui(Vmax) and current li(luax), and maximum power Pi(Pmax), which the device can
receive and remain intrinsically safe, must be equal to or greater than the voltage (Uo or Voc or Vt) and
current (lo or Isc or It) and the power Po which can be delivered by the barrier.

The sum of the maximum unprotected capacitance (Ci) for each intrinsically device and the interconnect-
ing wiring must be less than the capacitance (Ca) which can be safely connected to the barrier.

The sum of the maximum unprotected inductance (Li) for each intrinsically device and the interconnecting
wiring must be less than the inductance (La) which can be safely connected to the barrier.

The entity parameters Uo,Voc or Vi and lo,lsc or I, and Ca and La for barriers are provided by the barrier
manufacturer.

NI Field Circuit Parameters

Model 5331D, 5332D, 5333D, 5335D, 5337D and 5343B

Hazardous (Classified) Location . Non Hazardous Location
Class I,Division2, Groups, A,B,C,D T4..T6
Class |, Zone 2, IIC T4..T6 ) Associated Apparatus
: or Barrier

Ambient temperature limits
T4: -40 to + 85 deg. Celcius
T6: -40 to + 60 deg. Celcius

Terminal 1, 2

Vmax: 35V
Ci: 1.0 nF
Li:10 uH
@
6 3 This device must not be connected
5 4 M to any associated apparatus which
* uses or generates more than 250
VRMS
| SENSOR I
Revision date: Version Revision Page:
2018-08-27 V3R0 2/2
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Desenho de Instalacdo INMETRO

Para instalagédo segura do 5333A ou 5343A o seguinte deve ser observado. O modo deve
apenas ser instalado por pessoas qualificadas que sdo familiarizadas com as leis nacionais e
internacionais, diretrizes e padrées que se aplicam a esta area.

Ano de fabricagédo pode ser pego dos dois primeiros digitos do nimero de série.

Certificado DEKRA 16.0014 X

Marcas Ex nA [ic] IIC T6..T4 Gc T4: -40 < Ta < 85°C
Ex !C IIC T6..T4 Gc T6: -40 < Ta < 60°C
Exic llIC Dc

Normas ABNT NBR IEC 60079-0 : 2013; ABNT NBR IEC 60079-11 : 2013
ABNT NBR IEC60079-15 : 2012

Terminais Ex nA [ic] Exic
1,2 U<=35V Ui: 35V, I[i:110mA, li:10uH, Ci:1,0nF
3,4,6 Uo: 5V, lo:4mA, Po:20mW, Lo:900mH, Co: 1000uF

Notas para instalagao

Para a instalacdo em uma atmosfera de gas potencialmente explosivo, se aplicam as instru¢des a
seguir:

Para a instalagédo nA o transmissor deve ser instalado em um invélucro de metal, por exemplo,
gabinete em forma B que fornega um grau de protegéo de pelo menos IP54 de acordo com IEC60529
ou em um involucro com tipo de protegdo Ex n ou Ex e.

Para a instalagao Ex ic o transmissor deve ser instalado em um invélucro proporcionando um grau de
protecao de IP20, pelo menos, de acordo com a norma ABNT NBR IEC 60529. E o invélucro deve ser
adequado para a aplicagado e corretamente instalado.

Dispositivos de entrada de cabos e elementos de supressdo devem cumprir 0s mesmos requisitos.
Para temperatura ambiente >= 60°C, fios de resisténcia ao calor devem ser usados com uma faixa de
pelo menos 20K acima da temperatura ambiente.

Para a instalagdo em uma atmosfera de poeira potencialmente explosiva , se aplicam as instrugdes a
seguir:

O transmissor deve ser montado em invélucro de metal forma B de acordo com DIN43729 que esta
fornecendo um grau de protegéo de pelo menos IP6X de acordo com ABNT NBR IEC60529.

O invélucro deve ser adequado para aplicagao e instalado corretamente.

As entradas dos cabos e os elementos de obturagéo que podem ser utilizados s&o adequados para a
aplicacao e corretamente instalados.

A temperatura da superficie do involucro é igual a temperatura ambiente mais 20 K, para uma
camada de p6é , com uma espessura até 5 mm.
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Desenho de Instalacdo INNMETRO

Para instalagéo segura do 5333D ou 5343B o seguinte deve ser observado. O modo deve apenas
ser instalado por pessoas qualificadas que séo familiarizadas com as leis nacionais e
internacionais, diretrizes e padrées que se aplicam a esta area.

Ano de fabricagédo pode ser pego dos dois primeiros digitos do nimero de série.

Certificado DEKRA 16.0014 X
Marcas Exia IIC T6...T4 Ga
Exia llIC Da
Normas ABNT NBR IEC 60079-0 : 2013; ABNT NBR IEC 60079-11 : 2013
Areas Risco
Zona 0, 1, 2, 20, 21, 22, M1 Areas de nao Risco

T4: -40 < Ta<85°C |
T5: -40 < Ta <60°C |
T6: -40 £ Ta<45°C

Terminais:
3,4,5,6
Uo: 30 VDC |
lo: 8 mA
Po: 60 mW |
Lo: 35 mH
Co: 66 nF | Barrier
Terminais: 1,2 |
Ui: 30 VDC |
li: 120 mA
Pi: 0,84 W |
Li: 10 uH
Ci: 1,0nF
Revision date: Version Revision Page:
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Notas de Instalagao.

Em uma atmosfera de gas potencialmente explosiva, o transmissor deve ser montado em um
enclousure a fim de garantir um grau de protegcdo de no minimo IP20 de acordo com ABNT
NBR IEC60529. Se contudo o ambiente requer um nivel de protecao maior, isso deve ser
levado em conta

Se o transmissor € instalado em uma atmosfera explosiva exigindo o uso de equipamento de
protecao de nivel Ga e se o invélucro é feito de aluminio, ele deve ser instalado de modo que,
mesmo em caso de avaria rara, fontes de igni¢cdo devido a impacto e fricgéo, faiscas séo
eliminadas; Se o enclosure ¢é feito de materiais ndo metalicos, cargas eletroestaticas devem
ser evitadas.

Se o enclosure é feito de materiais ndo metalicos, cargas eletroestaticas devem ser evitadas.

Para instalagdo em atmosfera de poeira potencialmente explosiva, as instrugdes a seguir:
O transmissor deve ser montado em invélucro de metal forma B de acordo com DIN43729 que
esta fornecendo um grau de protegéo de pelo menos IP6X de acordo com ABNT NBR

IEC60529. O invélucro deve ser adequado para aplicagéo e instalado corretamente.

As entradas dos cabos e os elementos de obturagéo que podem ser utilizados s&o adequados
para a aplicagao e corretamente instalados.

Para temperatura ambiente >= 60°C, fios de resisténcia ao calor devem ser usados com uma

faixa de pelo menos 20K acima da temperatura ambiente.

A temperatura da superficie do invélucro é igual a temperatura ambiente mais de 20 K, por
uma camada de pd, com uma espessura até 5 mm.
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Document history

The following list provides notes concerning revisions of this document.

Rev. ID Date Notes

104 14/14 IECEX, FM and INMETRO approvals added

105 15/03 GL marine approval added

106 17/07 IECEX, FM and INMETRO installation drawings
updated

107 18/48 FM installation drawing updated
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